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Presenter: Mary Peterman

Florida Department of Transportation Engineering/CADD System Office
CADD Applications Development Specialist

What is Entity Manager (EMX) Used for ?

Entity Manager allows the user to draw graphical entities
with pay item data for QTO pre-attached, or place the pay
item data on entities after they are drawn.

Entity Manager helps enforce drafting standards with
tools for drawing primative entities on the proper
ByLAYER for the drawing that is open.

Entity Manager is evoked for the FDOT Ribbon, or can be
run by typing the Command “EMX” at the command line

Entity Manager stays resident during the Civil 3D Session
so it can be opened and closed quickly.
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Configuration

FDOT Pay Item database
(EntityManagerPayitemDatabase.txt)

The shipped default database of pay items, attributes,
adhochs, and symbology. This is used to restore defaults.

FDOT Rule Standards database for Filename / Layer /
Symbology (MasterStandards.xIsx)

FDOT Pay Item Criteria Includes formula data, etc.
(AECMERGE.xml)

TRNS*PRT Categories provides the numeric groupings
(FloridaCategories.xml)

FDOTEnNtityManager.Log is in the user's TEMP folder
C:\Users\rd964mp.CO\AppData\Loca\Temp\FDOTEntityManager.Log
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After First Execution 5

First execution, EMX reads the default
EntityManagerPayitemDatabase.txt

After the first execution, Entity Manager uses the custom
database you saved for your project

PayitemDB.xml allows custom changes to the pay
items

Use the “File > Save As...” icon to the database at
any time to a project, or share it with someone else.
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The File Menu s

Open Folder Icon

Open — Reads the custom pay item database (automatic on next EMX
startup)

Save — Saves the database as changes are made (does not save by
default!)

Save As — Saves custom pay item database to new location

Export - Saves a Pay Iltem database compatible with QTO
(AECMERGE.xml)

Default — Opens and loads the original pay item database text file
delivered with application (EntityManagerPayitemDatabase.txt).

The PayltemDB.xml is the “customized” pay item database for your project.
Any changes the user makes to the pay item data are saved to this
database. Favorites are also saved to this file. You can copy or Save As...
for another user or project. Once you open EMX, you can select to open
another customized database from the menu bar Open menu item. EMX
remembers your selection (or last Save As) to open in the next session.
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The View Menu

Show / Hide Categories Icon

Show or hides the pay item category tree view

Favorites
Add to Favorites
Remove from Favorites

Organize Favorites — open dialog to aide in editing,
importing and exporting favorites

Favorites list — is saved in the registry and with the
custom pay item database.
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3 Ergsion Control

3 Utitiies

3 Signalzation

3 Signing

3 Pavement Markings

3ms

3 Highway Lighting =l

rorites | Text fiiter 7 - Payitemtofind G |

tem | Description | Lil

spegraphy Topegraphy

P Asphalt Pavement (Edge) P

ARW Barrier Wall E

DG Buildings B
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NC Existing Fence Fence_ep
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[=1Topli2D Wireframe]

| \PayitemDB.xml
Loading finished.
-

Search Text Field

category and listing

Filter Text Field

text search)

13 Search for the next occurrence of the pay item id
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Finding Pay Items in the Database s

Type the pay item id to locate — jumps directly to

Type in first characters (numbers) — to display
dropdown list of available pay items

Type text to filter pay item or descriptions (a general

Finds the first occurrence, and lists all matching items

Search Next (Binocular Icon)
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k

1puteMethod
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-

rorites ~ | sidewalk - pay item to find £ |

tem I Description I Layer Block ‘ComputeMett |
NK Sidewalk (Fronts) SidewalkFr.

NKB Sidewalk (Backs) SidewalkBa..

W Back of Sidewalk SidewalkBa...

w Front of Sidewalk SidewalkFr...

526 1 2 | Pavers, Architectural, Sidewalk Pavers SY=IF(SY>0S
522 1 Sidewalk Concrete, 4" Thick SidewalkCo.. SY=IF(SY>0,S
322 2 Sidewalk Concrete, 6" Thick SidewalkCo... SY=IF(SY~>0,5
3SWB Sidewalk Base SidewalkBa... -
N Sidewalk (Proposed) Sidewalk_px

NE Sidewalk (Existing) Sidewalk_ex

7151412 Lighting - Pull Box, F&I, Sidewalk PullBox PullboxL  EA=IF(EA>0,
71514 42  Lighting - Pull Box, Relocate, Sidewalk PullBox PullboxL | EA=IF(EA~0,
7151452  Lighting - Pull Box, Remove, Sidewalk PullBox PullboxL

SOOr @ oo A&

EA:IF(EA:'LI

[=1Topli2D Wireframe]

Select object(s) for assignment: 1 found
Select object(s) for assignment:
-

Working with favorites

Manage favorites list

Draw entities with favorite pay items
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5 Guardral Removal
4 End Anchorage Assembly
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84 Pipe Handrai - Guiderall
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rorites ~ | 0536 7053611 % |

tem | Description | Layer Block CumpuleMeL‘
|

destrian... Roadway Design\Plan Features\Pedestriar/...

on Speci.. Roadway Design\Plan Features\Pedestriar/...

515 2111 Pedestrian/Bicycle Railing, Non Specified, Handrail
515 2112 Pedestrian/Bicycle Railing, Non Specified, Handrail
515 2113 Pedestrian/Bicycle Railing, Non Specified, Handrail
515 2114 Pedestrian/Bicycle Railing, Non Specified, Handrail
515 2115 Pedestrian/Bicycle Railing, Non Specified, Handrail
515 2119 Pedestrian/Bicycle Railing, Non Specified, Handrail
515 2121 Pedestrian/Bicycle Railing, Non Specified, Handrail
515 2122 Pedestrian/Bicycle Railing, Non Specified, Handrail
515 2123 Pedestrian/Bicycle Railing, Non Specified, Handrail
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LF=IF(LF>0,LI
LF=IF(LF>0,LI
LF=IF(LF>0,LI
LF=IF(LF>0,LI
LF=IF(LF>0,LI
LF=IF(LF>0,LI
LF=IF(LF>0,LI

LF=IF(LF>0,Ll v

LF=IF(LF>0Ll . End of pay items.
» 32 pay items found.

>. - FDOT_EMC_IDENTIFYENTITY Select entity:

ID Icon

Entity Attributes

entity

pay items
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Editing Pay Item data (both DB & entities) s

Displays the selected entity properties palette
Loads the properties with attached XData information

Allows the edit of the pay item data attached to the

Note this differs from editing the pay item database !

Use Highlight and Show to identify entities with or without
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Item Categories Entity XData | Select Pay Ilemsl
1y item data LI
€’ | Value | ;I
Ttem 0550 10110
cription Fencing, Type A, 0.0- 5.0" Height, Standard
El Fence
k
JputeMethod | LF=IF(LF=>0,LF*QF, (element_length)*QF)
JputeMetho... 0
ntityFactor | 1.00000
kscale
‘kLibrary LI
rorites ~ | fence 7052017 % |
tem Description | Layer Block CumpuleMeL‘

|
ncing, T.. Roadway Design\Plan Features\Fences\Fen...
55010110 Fencing, Type A, 0.0- 5.0 Height, Standard  Fence LF=IF(LF>0,LI
55010120 Fencing, Type A, 5.1- 6.0' Height, Standard  Fence LF=IF(LF>0,LI
55010130 Fencing, Type A, 6.1- 7.0' Height, Standard  Fence LF=IF(LF>0,L|
55010140 Fencing, Type A, 7.1- 80" Height, Standard ~ Fence LF=IF(LF>0,LI
55010150 Fencing, Type A, 8.1- 10.0° Height, Standard  Fence LF=IF(LF>0,L|
ncing, T.. Roadway Design\Plan Features\Fences\Fen...
55010210 Fencing, Type B, 0.0- 5.0' Height, Standard  Fence LF=IF(LF>0,LI
55010220 Fencing, Type B, 5.1- 6.0' Height, Standard  Fence LF=IF(LF>0,LI
55010230 Fencing, Type B, 6.1- 7.0' Height, Standard  Fence LF=IF(LF>0,LI v
550 10240 Fencing, Type B, 7.1- 8.0' Height, Standard  Fence LF=IF(LF>0,Li

| _"_I Select entity:

2007/ QMoo E&| i~

Applying and Manipulating Pay Items s

Append Pay Item Truck Plus (+) Icon
Appends selected pay items data to selected entities.

* Replace Pay Item Truck X (Green) Icon

Appends selected pay items data to selected entities
by replacing original data.

* Remove Pay Item Truck X (Red) Icon

Removes all EM pay item data from selected entities.

Add Pay Item (+) Icon

Adds the current pay item to the Selected Pay Items
list on the Pay Item Properties palette
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Item Categories Entity XData | Select Pay Ilemsl

1y item data

€’ | Value

rorites ~ | guardrail 7052017 % |

tem Description | Layer Block CumpuleMeL‘
520 1 8  Concrete Curb & Gutter, Special (Pensacol.. CurbFace LF=IF(LF>0,LI
520 110 Concrete Curb & Gutter, Type F CurbFace LF=IF(LF>0,LI
520 2 1 | Concrete Curb, Type A CurbFace LF=IF(LF>0,LI
520 2 2 | Concrete Curb, Type B CurbFace LF=IF(LF>0,LI
520 2 4 | Concrete Curb, Type D CurbFace LF=IF(LF>0,LI
520 2 8  Concrete Curb, Type RA CurbFace LF=IF(LF>0,LI
520 2 9 Concrete Curb, Special CurbFace LF=IF(LF>0,LI
520 3 Valley Gutter - Concrete CurbFace LF=IF(LF>0,LI
520 6 Shoulder Gutter - Concrete CurbFace LF=IF(LF>0,LI
525 1 Curb Asphaltic Conc CurbFace LF=IF(LF>0,LI
G Back of Curb CurbBack

SOOr @ oo A&

[=1Topli2D Wireframe]

WPolygon/CPolygon]: *Cancel*
Command: Regenerating model.
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Displaying What Entities Have Pay Items

Highlight / Show Pay Item data
Highlight / Show only objects with pay items
Highlight / Show only objects without pay items
Highlight / Show only objects with selected pay items
Clear highlight selection
Toggle to optionally highlight or show/hide objects

N/
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b
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-] FDOT Signs

=* Place Block Group

+/ QC Quick Check
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ﬁ Compbook B(?‘ Shape Labels
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DrawingL* | DSGNRDOL*  x \a
T Entity Manager 1-ITopli2D Wireframe]
- View - [[#]/1d |85 83 B 55 88 |- | Tooks - @~
Item Categories Entity XData | Selecj.Pay Ilemsl
1y item data |
€’ | Value | 1=
n FDOTENtityManager
0 9
Ttem FSwW
cription Front of Sidewalk
=r SidewalkFront
k =
1puteMethod
1puteMetho...
ntityFactor 1.00000 LI
rorites ~ | sidewalk 7052017 % |
tem I Description I Layer Block ‘ComputeMett |
NK Sidewalk (Fronts) SidewalkFr.
NKB Sidewalk (Backs) SidewalkBa..
W Back of Sidewalk SidewalkBa...
w Front of Sidewalk SidewalkFr...
526 1 2 Pavers, Architectural, Sidewalk Pavers SY=IF(SY=0,8
522 1 Sidewalk Concrete, 4" Thick SidewalkCo... SY=IF(SY>0,S
322 2 Sidewalk Concrete, 6" Thick SidewalkCo... SY=IF(SY~>0,5
3SWB Sidewalk Base SidewalkBa... -
N Sidewalk (Proposed) Sidewalk_px
NE Sidewalk (Existing) Sidewalk_ex
7151412 | Lighting - Pull Box, F&I, Sidewalk PullBox PullboxL | EA=IF(EA~0,
L: itl
71514 42 | Lighting - Pull Box, Relocate, Sidewalk PullBox PullboxL | EA=IF(EA>0,
71514 52 | Lighting - Pull Box, Remove, Sidewalk PullBox \local\temp\DSGNRDO1_1_1_5942.sv$ ...

PullboxL  EA=IF(EA-0, +
| »

SOOr @ oo A&

Command :

58| -

Geometry types with Pay Items

we have seen), and Area based objects

Entities can represent “Point” objects, Linear Objects (as

Blocks can be placed as single insertions or by
evoking the Place Block Group Tool

Linear Objects controlling geometry for Pavement

Striping can be place that striping using the Pavement

Markings Tool
Areas can have Pay items too

13
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Manage Help ExpressToos Add-Ins FDOT (E3R2
1+ =] FDOT Signs 7 QC Quick Check
aﬂf . £3 TRuS*port [ Linear Backup S O
=% Place Block Group ‘.—f_m Unload Quick Check

Entity =
Manager B3 pavement Markings

Links &

B compbook [k shape Labels
B i &:‘ & BoreHole | Contacts

D Quick Check Reports

Draw Pay Items Quantities Quality Control GeoTech Help

Existing
2 Lengthcale 6 Swap Parts LaneSiope
Tools
Drawing1* | DSGNRDO1* x
IT Entity Manager

[=1Topli2D Wireframe]

- View - [[4]|1d | 8% 53 & 55 53 |- | Took - @-

Item Categories Entity XData | Select Pay Ilemsl

1y item data |
€’ | Value | 1=
n FDOTENtityManager

0 10

Ttem 055010110

cription Fencing, Type A, 0.0- 5.0' Height, Standard

ar Fence

k

1puteMethod | LF=IF(LF>0,LF*QF (element_length)*QF)
1puteMetho... 0

ntityFactor 1.00000 LI
rorites ~ | sidewalk 7052017 a
tem Description | Layer Block CumpuleMeL‘
|
ncing, T.. Roadway Design\Plan Features\Fences\Fen.
55010110 Fencing, Type A, 0.0- 5.0 Height, Standard ~ Fence LF=IF(LF>0,LI
550 10120 Fencing, Type A, 5.1- 6.0° Height, Standard | Fence
550 10130 Fencing, Type A, 6.1- 7.0' Height, Standard | Fence
550 10140 Fencing, Type A, 7.1- 8.0' Height, Standard | Fence
550 10150 Fencing, Type A, 8.1- 10.0" Height, Standard | Fence
ncing, T.. Roadway Design\Plan Features\Fences\Fen.
550 10210 Fencing, Type B, 0.0- 5.0' Height, Standard | Fence
550 10220 Fencing, Type B, 5.1- 6.0' Height, Standard | Fence
550 10230 Fencing, Type B, 6.1- 7.0' Height, Standard | Fence
550 10240 Fencing, Type B, 7.1- 8.0' Height, Standard | Fence Select object(s) for assignment:
| Command: Regenerating model.
2007/ QMo R & i~
T Home [Insert  Annotate Modify ~ Analyze View Output Manage Help ExpressToos Add-Ins FDOT 0=
o 52 wmport survey Data (- | - - i AENEAEARAE @
o . llgE - 3 Unsaved Layer Stats -
iy <€ Points =1 -5 s —ayer ate oy
(5 surfaces - i ~ af - ¢ Xl [l sod - M
Palettes v Create Ground Data v Create Design « Profie & Section Views Layers - Ciipboard
Drawing1* DSGNRDO1* »
/T Entity Manager

- View - 4] id |85 9 B2 5% 83 7% | Tooks -
ltem Categories | Enticy XData | Select Pay Iiems |

I ITepll \‘I‘Th
i

& 84 Profie Features

Quantity Features

= B4 Maintenance of Traffic
T4 Crossover - Temporary
T4 Temporary Roadway Features
T4 Work Zone Signs

4 Channelzing Devices

4 Lighting Devices
T4 Advance Warning Arrow
4 Variable Message Sign
4 Pavement Markers
T4 Signals

[~

Pay item to find §f |

rorites ~ | marker

tem | Description | Layer + |
L0278 Temporary Retroreflective Pavement Mark..  RPM1
2mExist.. Remove Existing Object Marker Sign$
JbjMark... Existing Object Markers Sign$
JbjMark... Existing Object Marker Panel Activ,
bjectMa... Proposed Object Marker Sign¢
bjectMa... Object Marker Pane! Activ
70510 1 Object Marker, Type 1 Objer
70510 2  Object Marker, Type 2

70510 3  Object Marker, Type 3

70510 4 Object Marker, Type 4

06 3 Retro-Reflective Pavement Marker (MD/W)

06 3 Retro-Reflective Pavement Marker (MD/Y)

06 3 Retro-Reflective Pavement Marker (Y/Y)

So0reroras

15 pay items found.
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Tools Tab 5

Tools & Options

Show Layer Warning — If checked the user will be
prompted when the current layer is not found in the
FDOT Level rules database for the current drawing
file name.

Show Drawing Tools — If checked the tools menu will
display for drawing object and attaching pay item
data.

Show Entity Tool Tip — If checked, display tool tip pay
item data when the cursor passes over objects with
pay item data.
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Home

g 5 mport Survey Data & -+ % - o - i - A A AE) X7 - o) ] [&] [+ [&
pace € points - bR o[ A -& Unsaved Layer State B PRI aE
BE|@smees G - @ OedE 2 = il Jelsn B Sl

Palettes v | Create Ground Data v | Create Design v | Profie & Section Views | Layers

i DSGNRDO1* b

- View - [/ id |55 & B2 %5 88 |#%- | Took - @~
ltem Categories ENtity XData | Select Pay liems |

1y item data |~
e | Value | =0
n FDOTEntityManager

0 10

Ttem 0570 11

cription Performance Turf j
ar Sod

k

JputeMethod | SY=IF(SY>0,SY*QF,(element_area/9)*QF)
JputeMetho... 0
ntityFactor | 1.00000

Py - |
rorites - | performance 7 - Pay tem tofind £ |

tem | Description [Layer ]
570 1 1 Performance Turf Sod
370 1 2 Performance Turf, Sod Sod
70511 4 Delineator, Flexible High Performance Delin

7131021.. Preformed Tape, High Performance, Arro... | DirAr
7131021.. Preformed Tape, High Performance, Arro...  DirAr
7131021.. Preformed Tape, High Performance, Arro...  DirAr
7131021.. Preformed Tape, High Performance, Arro.. | DirAr
7131021.. Preformed Tape, High Performance, Arro... | DirAr
7131021.. Preformed Tape, High Performance, Arro...  DirAr
7131021.. Preformed Tape, High Performance, Arro...  DirAr
7131021.. Preformed Tape, High Performance, Arro.. | DirAr
7131021.. Preformed Tape, High Performance, Arro... | DirAr
7131021...  Preformed Tane. Hinh Performance. Arro, Dir’fr hd

Command: *Cancel*
»|~ Type a command

DOO77@MODE &)
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Application Options

Options
Which Categories to Display?
User Settings

Layer Confirmation default

Drawing Toolbar Default

Tool Tip defaults

Vertical versus Horizontal View layout
Hide categories in tree View

Program application configuration variables

Definition for Units and Formulas

space v@-‘ Paints -
[ E & surfaces -

Palettes v Create Ground Data v Create Design « Profie & Section Views Layers - Ciipboard

Home Insert Annotate Modfy Analyze View Output Manage Help ExpressTook Add-Ins  FDOT

0=
%» 5 mport Survey Data & -+ % - o - i - & & PPNCEAE 4 E
Paste

o
Unsaved Layer State -

SRR I
©-E g-| @8- | 9%dfOo - s

Drawingl* » {_DSGNRDO1 ]

T Entity Manager

2 - View - [k | id |8] &R 83 %] &5 85 | Took - @~
Ttem Categories | Entity XData | Select Pay Items|

|- 1ToplI2D Wireframe]

& Topography

4 Structures

8 RW Items for Roadway Plans
8 Roadway Design

14 Drainage

4 Erosion Control

14 Utiities

4 Signaization

?33 Swgnm LI
vorites - | Text fiter 7 - payitemtofind &% |

ltem | Description | Layerﬁl
ARW Barrier Wall Barrit
LDG Buildings Build
GB Curb and Gutter (Back) CGBz
GF Curb and Gutter (Face) CGFa
WYE Driveway (Drive, Lane, Turnout) Drive
NC Existing Fence Fence
P Pavement Misc (Misc. Parking, guardrail p.. | Pavth
HLDR Shoulder Edge, Paved Shidr
WK Sidewalk (Fronts) Sidev
‘WKB Sidewalk (Backs) Sidev
FsSP Traffic Separator TrafS
VETEDGE Wetland Edge Wetl;
tructures | Structures

LCONST  C/L of Const. w/stationing CLCo Command:

BAS Existing Bridge Approach and Slabs

Bri;;lj o Options changes cancelled.
»

> |~

7/8/2013

14



